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Learning Outcomes

By the end of this unit the learner will be able to:

v' Create formulas in a worksheet

v Insert functions in a worksheet

v" Reuse formulas
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UNIT 02 PERFORMING CALCULATIONS

EXCEL FORMULAS

Formulas are mathematical expressions that operate on cell contents. When cells contain
numerical data, you can perform multiple mathematical operations on the cell content as your
worksheet requires. The results of these operations will be shown in the cell that contains the
formula. Formulas can be simple, like adding two cell values, or quite complex, involving
multiple mathematical operations.

THE FORMULA BAR

Located just below the ribbon, the Formula Bar is where you will type in functions for a selected
cell:
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The Formula Bar is comprised of the Name Box(1); the Insert Function,Enter, and
Cancelbuttons(2);and the Formula Bar text box (3):
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The Formula Bar text box will display the contents of the selected cell and allow you to edit its
contents. The Insert Function button allows you to insert functions that you type into the
Formula Bar into the currently selected cell. The Enter button will enter any formula that
appears in the bar into the current cell, while the Cancel button will cancel the process and
clear the Formula Bar entirely.

ELEMENTS OF AN EXCEL FORMULA
Formulae are always preceded by an equals sign (=). Formulae can contain cell references (like

A1), numbers (like 23), or functions (like SUM(B2:B9)). Enter a formula by typing directly into a
cell or into the Formula Bar:
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SUM - x v =1+1

=1+1

=A1+23, = d2-c2, and =B10+b11/C6 are all valid formulae; cell references are not case-sensitive.

If you include a cell reference in a formula (like =B3*6), and that cell reference itself contains a
second formula (like =B1+B2, stored in B3), that second formula (=B1+B2) will be evaluated

first, and the result will be used in =B3*6.

You can tell if a cell contains a formula by making it active. If there is a formula in the active cell,

it will be shown in the Formula Bar:

CoMMON MATHEMATICAL OPERATORS

Excel uses eight basic mathematical operators:

Name Symbol
Exponent A
Multiplication *

Division /

Example

1072 =100

10*2 =20

10/2=5
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Addition + 10+2 =12
Subtraction - 10-2=8
Equivalence = 10=10
Greater Than > 10>2

Less Than < 2<10

THE ORDER OF OPERATIONS

The common mathematical operators shown above are listed from top to bottom in order of
precedence. This means that Excel does not simply calculate expressions from left to right;
certain operations are performed before others. Multiplication and division, addition and
subtraction, and the greater than/less than operations each have equal precedence.

You can impose your own order of operations by enclosing expressions in parentheses (). The
operations inside the parentheses will be evaluated before the operations outside.

If you have parentheses within parentheses, such as ((2+3)*4), the expression in the inner
parentheses, (2+3) =5, will be evaluated first, and the result will be used to evaluate the
expression in the outer parentheses, (5*4) =20.

One easy way to remember precedence order is to remember the word “BEDMAS,” which
stands for Brackets (aka Parentheses), Exponents, Division, Multiplication, Addition, and
Subtraction. Note that:

= Division and Multiplication have equal precedence, calculated from left to right.
= Addition and Subtraction have equal precedence, calculated from left to right.

FUNCTIONS

Functions are pre-made operations that are used to perform calculations. Excel features a
number of functions relating to basic math, financial applications, logic, date and time, and
more.
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For example, if you want to add a column of ten numbers, you could type =A1+A2+A3+...etc.,
but that would quickly become tedious and would also make the spreadsheet harder to work
with. A much more efficient way of performing this calculation is to use the SUM function:

C10 ~ S || =SUM(A1:A10)
A | B | C D F ,

1 1

2 2

3 3

4 | 4

5 | 5

6 &

7 7

g | 8

g 9

1? 10 | 55_|

In this example, we typed “=SUM(“ and then added the A1 to A10 cell range (A1:A10). Upon
added a closing parenthesis and pressing Enter, the sum of all these numbers was calculated
and displayed (55). That is much easier than typing out a very long formula and allows for more
flexibility if additional rows are added within the defined range.

THE FUNCTION LIBRARY

Functions have been a very important part of Excel right from the beginning because they make
data computation and analysis very easy. In fact, Excel features over 300 built-in functions to
calculate or provide information regarding:

= Databases
=  Date and time
= Engineering

= Finance
=  Worksheet metadata
= Logic

» Lookup and reference

= Math and trigonometry
= Statistical analysis

= Text strings
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You can browse the nine categories available in the Formulas tab:

= -

Home Insert Page Layout Data Review
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Function = Used ~ < = =  Time~ Reference~ Trig~ Functions~

Function Library

You will likely use many of the functions available under AutoSum, Financial, and Math & Trig.
Remember to check the Recently Used menu to look at functions you have used in the past.

ComMMON FUNCTIONS IN EXCEL

Using the AutoSum button, you can quickly insert some of the more commonly used functions
into a worksheet. The followingbasic mathematical and statistical analysis functions are

included:
Name Usage
Sum Add values together in a specified range or argument.
Average Determine the average value in an argument.
Count Determine the number of cells that contain a specific
Numbers value in a specified cell range.
Max Find the highest of the values in an argument.

Min Find the lowest of the values in an argument.
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The AutoSum Button

To use the AutoSum command, click the cell immediately below (if summing a column of data)
or to the immediate right (if summing a row of data) of the data you want to sum.Next, click
Formulas ->AutoSum:

H ©- -

File Hame Insert Page Layout Farmulas

ro2 E OIS 38 LLLL

Insert  AutoSum Recently Financial Logical Text Date & Lookup & Math &  More
Function - Used ~ v A *  Time~ Reference~ Trig~ Functions -

Function Library

BS - fe
A | B | ¢ | b | E | F G | H
1| Store#1 Store#2 Store#3
2 |pay1 6586 5848 7898
3 |Day2 9215 4587 6745
4 |Day3 1241 4785 4523
| [
A

(Additional functions are available by clicking the drop-down arrow.) Excel will scan the data in
the column/row. The column or row of data to be summed will be highlighted by an animated
border:

SUM = X « | =SUM(B2:B4)
A | B | ¢ | D | E |

1 .Stare H#1 .Stare #2 Store #3

2 Dayl 6586 SB48 TE98

3 Day2 9215 A587 6745

4 |Day3 I __ 12411 4785 4523

5 | [ssum(BZe)

& SL.If'-.-'h:numI:n=.-r1r [number?], ...]

Press Enter to complete the AutoSum command:
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A , B , C | D |
1 Store #1 Store #2  Store #3
2 Dayl 6586 5848 7898
3 |Day2 9215 4587 6745
4 Day3 1241 4785 4523
] 17042
ol L

THE FORMULA AUTOCOMPLETE FEATURE

The Formula AutoComplete feature allows you to type function names directly into cells. While
typing the formula name, the matching functions will filter themselves based on what you have

entered. Click a function to use it:

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that contain numbers

Once you have decided on a function to use, Excel will prompt you to enter each argument as
necessary. Add the closing parenthesis, press Enter, and Excel will calculate the value:

A I B | c | D | E | F | G |
1 _Stc:rre #1 Store #2  Store #3 l
2 |pay1 6586 5848 7898 [=AvERAGE(B2:D4)
3 |Day2 9215 4587 6745 I
4 |pay3 1241 4785 4523l
5 17042
=

Reuse Formulas

THE Cut, CoPY, AND PASTE COMMANDS

Just like many applications that you work with, Excel allows you to move and/or copy cells and
their contents to other areas of workbook or even other applications. You can move a cell or its



Microsoft Excel

contents using the Cut and Paste commands. If you wanted to copy a cell and its contents
instead, you could use the Copy and Paste commands. You can find all of these commands in
the Clipboard group of the Home tab:

-

Insert Page Layout Formulas
& e L
B E}E’C“t Calibri 1< A A
X Copy ~
Paste - | - -
- ~ Format Painter ru - O L
Clipboard r Font Fa

These commands are also available on the right-click menu.

Keyboard Shortcuts

In addition to the commands in the Clipboard group of the Home tab, you can also perform the
Cut, Copy, and Paste commands using keyboard shortcuts. To use the Cut command, press Ctrl
+ X. Copy is performed by pressing Ctrl + C, and Paste is performed by pressing Ctrl + V.

PASTE SPECIALOPTIONS

Paste Specialcan be a very useful Excel feature when trying to move data and objects around in
your workbooks, as well as move them to and from other applications. Paste Special’s options
can be used to perform a lot of operations that might be tedious to perform using other Excel
tools.Paste Special does indeed paste data, but it also allows you to perform operations on the
destination cells using the pasted data.

Consider the following worksheet. It lists quantities in column A, prices in column B, and sales
(A*B) in column C:
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A B C
1 |Quantity Price Sales
2 8 5 78.00 5 624.00
3 | 6 $ 95.00 &% 570.00
4 | 73 S 48.00 53,504.00
5 | 2 % 66.00 & 132.00
B | 67 S 25.00 $1,675.00
7 2 § 8400 & 168.00
8 | 4 § 35.00 5 140.00
9 46 $ 15.00 % 690.00
10 | 7 S 33.00 S 23100

Suppose that all prices are to be raised by 20%. You can manually enter the new prices, use a
formula in a new column to calculate the prices, or you can use Paste Special.

To use Paste Specialin this situation, enter the value 1.2 (the numerical equivalent of 120%) in
cell D1. Then, right-click D1 and click Copy:

D1 - fe 1 Calibri ~ 11 | A A $ - 05 s
= & - - - &0 00 f

A | B | c B. I = | .& _, i -:.u:ul

1 |Quantity Price Sales ~=l

2 | 8 S 73.00 $ 624.00 g Cut

3 6 % 9500 $ 570.00 (e Copy

4 | 73 $ 48.00 $3,504.00 Iy Paste Options:

5 | 2 % 66.00 S 132.00 o

[ 67 $ 25.00 $1,675.00 O

?_ 2 $ 8400 $ 168.00 Paste Special...

8 | 4 $ 3500 $ 140.00 O Smart Lookup

Next, select the prices in column B.Right-click on the selected area and clickPaste Special:



Microsoft Excel

4 A | B | C | D | E | F
1 |Quantity Price  Sales | 12
2 85 7800 i |1 A A% B
3 6| $ 95.0 o e
— e - - el ow B .
4 73 $ AR B I = A f—— 00 =0
5 2| $ e6.00 1 s 132.00
6 67| § 25.00 6 Cut
8 45 35.0 "E, Paste Options:
9] 46 & 15.0 B - S -
10 7l $ 33.0 [) ls LA LEP 2 o
1 Paste Special... b | Paste
12_ D Smart Lookup % .ﬁ'_h‘ 'ﬂf
This will display the Paste Specialdialog box:
Pascte Special ? >
Paste
@Al () All using Source theme
{:} Formulas C} All except borders
() Walues () Column widths
l[:} Formats l[:} Formulas and number formats
{:} Comments {:}l Values and number formats
I[:} Validation All merging conditional formats
Operation
(®) Maone () Multiply
() Add () Divide
() Subtract
|:| Skip blanks |:| Transpose
o1 o
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There are a number of options In the Paste Specialdialog box that you can choose from. To
increase the prices in the selected range by 20%, we want to multiply each price in the selected
range by 1.2. Therefore, select the Values and Multiply radio buttons and then click OK:

Paste Special ? ot
Paste

Al () All using Source theme

OEnrmuIas OAII except borders

@yalues l:::l Column widths

() Formats () Formulas and number formats

l:::l Comments l:::l Values and number formats

CI Yalidation All merging conditional formats
Operation

O Nane @iMultiply;

O Add ) Divide

() Subtract

[ ] skip blanks [ ]Transpose

Paste Link | ok N - Cancel

Returning to the worksheet, you will see that the prices have now been increased by 20%, and
Sales have increased as well, taking the new prices into account. The currency formatting
applied to column B also remains:

C
Sales
5 624.00
5 570.00
53,504.00
5 132.00
51,675.00
$ 168.00
5 140.00
$ 690.00
5 23100
[ rren |

A B ,
~ |Quantity Price

5 93.60
5$114.00
$ 57.60
5 79.20
S 30.00
$100.80
S 42.00
$ 18.00
S 39.60 1
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Note that you can access some additional paste options by clicking the Home - Paste drop-
down menu:

= ¥ Cut

ER® Copy ~
Paste e
- ¥ Format Painter

Paste Values
s il il

%
123 "123 123
Other Paste Options

= TIET " TRET = TR =]

% les L |5

Paste Special...

Or, by right-clicking a destination on the worksheet and moving your cursor over the Paste
Special sub-menu:
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J6 Cut
Ez Copy
m Paste Options:

[) Lo LA LER 2 |
Paste Special... I} F | Paste
e = il il
Smart Look B
@ mart Lookup D ﬁ: %ﬁ =
H e e il
Insert Copied Cells... o [ea [
Delete... Paste Values
Clear Contents B
123 123 423
= ick Analysi
Quick Analysis Other Paste Options
Filter L R - S-
] a
o | e W e

Paste Special...
¥3  Insert Comment =F

RELATIVE REFERENCES

Worksheets are composed of rows (horizontal, referenced with numbers) and columns
(vertical, referenced with letters). The intersection of each row with a column forms a cell, and
each cell is given a name in the “ColumnRow” format. These are called relative referencesand
are typically the most commonly used type of reference in Excel. Such references are flexible in
that they change depending upon the position of the formula.

ABSOLUTE REFERENCES

While relative references are fine for many, if not most situations,if data moved around or
copied using AutoFill, relative cell references can create incorrect and confusing results. To
avoid this, absolute cell referencesare used. These references use dollar signs (S) to make sure
a formula always references the same location, no matter where it is moved.

You can assign absolute cell references in three ways:

»  SColumnSRow: Both the row and column designation won’t change (SAS1).
*= SColumnRow: The column designation won’t change, but the row can (SA1).
* ColumnSRow: The row designation won’t change, but the column can (AS1).
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MIXED REFERENCES

Mixed references are cell references that include a mix of absolute and relative references. For
example, SColumnRow (SA1) is a mixed reference because while the column designation is an
absolute reference, the row designation is relative. Additionally, ColumnSRow (AS1) is also a
mixed reference because the row designation is an absolute reference, while the column
designation is a relative reference.



